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1 Tutorial scenario 

Using the Online Filing software in a firm of patent attorneys 

Our scenario uses the British patent attorneys' firm, IP Partners, as an example. The firm acts as European 
representative for companies in several different countries and is based in Cambridge, United Kingdom. IP 
Partners have recently decided to start using the Online Filing software in their office.  

The team at IP Partners is made up of patent attorney David Kilburn, two paralegals Jennifer Hancock and Oliver 
Barber, attorney's assistant Elizabeth Miners and an administrator (unnamed). In the course of our exercises, 
David Kilburn will be replaced as patent attorney by his colleague Jennifer Hancock and two American trainees, 
Patricia Baxter and Alex Haselmere, will join the IP Partners team.  

User privileges 

At IP Partners, different staff members have different privileges in the system, depending on their role. In Online 
Filing, these user privileges are assigned by the system administrator.  

 Paralegals may draft and check applications when they are ready for signing, they may also make any 
necessary corrections and attach documents. 

 Attorneys may perform all business functions such as drafting, signing and sending. 

 Assistants may send applications to the European Patent Office and maintain the Address Book. 

Electronic transmission of data 

IP Partners have recently taken on a new client, an American company called Universal Engineering, based in 
Los Angeles, California. Universal Engineering sends him all its documents electronically. 

Online Filing accepts files prepared in PDF-Format. 

 
It also accepts files prepared in XML-Format. 

 

Application templates and filing of data 

IP Partners anticipate that the filing office, names and payment details will be the same for every application they 
submit on behalf of Universal Engineering. IP Partners create a template with the relevant data in order to save 
time when completing the forms. The applications are filed in a folder labelled by the company's name, with 
subfolders for each year. 

Request for grant of a European patent 

IP Partners prepare applications in the Online Filing software using Form EP(1001E2K) Request for Grant of a 
European Patent (EPC 2000). 
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Sending applications to the EPO via a secure Internet connection 

For the purposes of this scenario, the team is going to use the "batch send" functionality, that is, they will send 
multiple applications to the EPO at the same time for filing. The assistant will use her personal smart card to 
transfer the applications that are ready to send to the OLF server at the EPO. The data will be encrypted and 
transmitted over a secure Internet link. 

 

Figure 1: Inserting smart card into card reader 

Confirmation of receipt by the EPO 

Applications are received and stored on the EPO server in The Hague. The EPO server issues a receipt, 
showing the exact date and time of receipt, down to the second. The receipt is stored in the Online Filing 
software together with the sent application. IP Partners also make a copy and store it in a local folder. 
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2 Online Filing in a networked environment 

In our example, the applicant, Universal Engineering of California, USA, prepares all the PDF documents relating 
to its patent applications and shares these within a networked Online Filing installation with its authorised 
representative, IP Partners in Cambridge, England. IP Partners then submit the completed applications to the 
EPO in The Hague. 

 

Figure 2: Example of a networked scenario 

IP Partners have installed the Online Filing software on a server. All users can access the server from their own 
PC and work with folders and documents. 

 

Figure 3: Example of a networked environment 
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3 User management in Online Filing 

Objective 

We want to assign privileges to Online Filing users according to their roles in the company. 

Step by step 

We are going to assign privileges for an attorney, a paralegal and an attorney's assistant. In our example the 
company's policy specifies that all users must log in with a user name and password. 

We will start with a tour of what is available. After that we are going to 

 define groups, 

 create profiles to assign privileges, 

 map the profiles to the groups, 

 add individual users to the groups, 

 re-activate blocked users, 

 activate folders for specific groups. 
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3.1 User administration - Overview 

 Log on to File Manager with the Administrator ID. 

 In the File Manager's menu, select Tools > User Administration. 

User Administration always opens in the Users tab. 

This is where all the individual persons allowed to use the Online Filing software are listed. Their names, user 
names and passwords are entered by the person acting as Administrator. 

The user Administrator already exists and cannot be deleted. The administrator can change his or her 
password, but not the first/last name or login name, which is why these fields are greyed out. The administrator 
cannot be removed from the Administrators group either. 

The purpose of the following process is to demonstrate that you cannot delete the administrator, not even 
accidentally: 

 Click the Delete button on the left. 

 
An error message appears, informing you that the administrator cannot be deleted. 

 Then click the Delete button in the middle. 

An error message appears, informing you that the administrator cannot be removed from the 
Administrators group. 

 

Figure 4: Administrator as the first user in User Administration 
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 Click the Groups tab. 

This is where groups defined by the Administrator are listed. The Administrators and Users groups are 
already set by default and should not be changed. 

 

Figure 5: User administration - Groups tab 

 Click the Profiles tab. 

This is where the privileges are listed that can be assigned to each group. 
They can be grouped into four headings: 
 Address Book Management 
 Application Workflow 
 Folder/Data Management 
 User Management. 

 At the moment we cannot see any privileges under these headings. We will look at the full list once we have 
assigned one or more profiles to a group. 

 Click the Mapping tab. 

Here you can assign the profiles to groups. 

 To start the exercise, return to the Groups tab. 
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3.2 Creating groups 

We are now going to create separate groups for the IP Partners team and call them Attorneys, Assistants and 
Paralegals. The Administrators and Users groups will remain unchanged. 

 Click the New button in the Groups screen. 

 
 In the middle panel enter Attorneys in the Group Name field. 

 Repeat this process to create groups called Assistants and Paralegals. 

 Finally, click the last of the new entries in the column on the left. 

Your screen should look like this: 

 

Figure 6: User Administration - groups created 

Saving your data 

It is important to save your work after each operation. In our example, we have created three new groups, but 
have not yet saved them. 

A small grey arrow appears to the right of new or changed entries. The status bar also indicates the number of 
entries with unsaved changes in the current tab. 

 Click the Save All button to save your changes in all tabs. 

 
 Click the Revert All button in order to discard all changes since the last saving. 
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3.3 Creating profiles 

The Profiles tab allows you to edit the list of privileges to be assigned to each group. 

Three standard profiles are created when you install the Online Filing software: 

 Administrators profile - this profile is mapped to the Administrators group. This assignment cannot be 
modified. You cannot deactivate the privileges under User Management nor can you delete the 
Administrators profile. 

 Default administrator profile - this profile can be used as a template to provide additional user groups 
with administrator rights as well as to set specific rights restrictions. The settings under User Management 
can therefore be edited. 

 Default user profile - this profile is suitable for user groups mainly involved in processing applications. The 
Edit Maintenance Fees privilege under Folder/Data Management is deactivated. 

We are now going to create three suitable profiles for the user groups we just created. We will not make any 
changes to the three default profiles. 

Attorneys 

In our example, the attorneys' group will have all privileges for the Address Book management, application 
workflow and folder/data management, but NOT for the user management. 

 Click the New button in the Profiles tab in order to create a new profile. 

 
 In the middle panel enter Attorney profile in the Profile Name field. 

 Click the Save All button. 

 
 Tick the check boxes for Address Book Management, Application Workflow and Folder/Data 

Management in the Privileges for "Attorney profile" panel. 

User Management is NOT selected. 

In the Description field enter Address Book Management, Application Workflow and Folder/Data 
Management and click the Save All button. 
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Your screen should look like this: 

 

Figure 7: Attorney profile created 
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Paralegals 

In our example, paralegals will have privileges for the Address Book management and most privileges for the 
application workflow, but will NOT have privileges relating to signing or sending applications. They will NOT have 
privileges for the user management. 

 Click the New button in the Profiles tab. 

 In the middle panel enter Paralegal profile in the Profile Name field. 

 Click the Save All button. 

 Tick the check boxes for Address Book Management and Folder/Data Management. 
User Management is NOT selected. 

 Under Application Workflow double-click the Application sub-heading to open the list. 

 Clear the check boxes for Remove Signature/Signatures, Send Application and Sign Application. 

This removes these privileges from this profile. 

 In the Description field enter Not remove signature(s) / not send application / not sign application. 

 Click the Save All button. 

Your screen should look like this: 

 

Figure 8: Paralegal profile created 
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Assistants 

Assistants manage the Address Book. Assistants should not have any privileges relating to the application 
workflow, with the exception of sending applications. Nor should they have any user management privileges. 

 Click the New button in the Profiles tab. 

 In the middle panel enter Assistant profile in the Profile Name field. 

 Click the Save All button. 

 Tick the check box for Address Book Management. 
Folder/Data Management and User Management are NOT selected. 

 Under Application Workflow double-click the sub-heading Application to open the list. 

 Tick the check box for Send Application. 

 Enter Send Application ONLY in the Description field. 

 Click the Save All button. 

Your screen should look like this: 

 

Figure 9: Assistant profile created 
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3.4 Mapping profiles to groups 

We have defined our groups and profiles. Now we are going to associate them with one another. 

 Click the Mapping tab. 

 Click a group name on the left and then tick the check box to assign the associated profile in the middle 
panel.  

In the example below, the Paralegal profile is selected as an assigned profile for the Paralegals group. 

 Continue in the same manner to assign the Attorney profile to the Attorneys group and the Assistant 
profile to the Assistants group. 

 Click the Save All button. 

 
To make sure that each group has the privileges you intend it to have, click each group name in turn and scroll 
down the Summary of privileges on the right. 

 You can assign multiple profiles to a group. This gives the group all the rights of both profiles. 

Your screen should look like this (Paralegals selected): 

 

Figure 10: Mapping privileges to Paralegal Profile 
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3.5 Adding users to groups 

Now that we have set up the structure of groups and profiles we are going to add individual users. For demo 
mode purposes the login name and the password will be David Kilburn's first name, in lower-case letters. 

 Click the Users tab and then click the New button in the left panel. 

 
 In the middle panel enter David as the First Name and Kilburn as the Last Name. 

 Enter david as the Login Name. 

 Enter david as the Password and enter it once again in the field Verification. 

 Click the Save All button. 

 
Next, we will add the new user to the Attorneys group. 

 Make sure that David Kilburn is selected. 

 Click the New button in the middle. 

 

Figure 11: Add new user to group 
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 In the Add User to Group panel tick the check box for Attorneys and click Add. 

 

Figure 12: Select group(s) for user 

 Back in the Users screen, click the Save All button. 

David Kilburn now has all the privileges available to Attorneys. Scroll through the Summary panel on the right 
to check the list. 

Your screen should look like this: 

 

Figure 13: User added to Attorneys group 
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 Repeat this process to add Elizabeth Miners to the Assistants group. 

Your screen should look like this: 

 

Figure 14: User added to Assistants group 
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3.6 Adding user to a second group 

In our example, IP Partners have decided that one of their attorneys should also be responsible for system 
administration. This is particularly useful should the Administrator be absent.  

We will therefore add David Kilburn to the Administrators group to give him all administrator privileges. 

You can add a user to a group either in the Users tab (as described in the previous chapter) or in the Groups 
tab: 

 Click the Groups tab. 

 Select the group Administrators. 

 Click the New button in the middle and select Add Users. 

 In the Add User to Group window, tick the check box for David Kilburn. 

 Click Add. 

 

Figure 15: Adding user to the Administrators group 

 Back in the Users screen, click the Save All button. 
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Your screen should look like this: 

 

Figure 16: User added to Administrators group 
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3.7 Unblocking a user account 

The assistant Elizabeth Miners mistyped her password three times in succession when logging on to File 
Manager. A message appears informing her that her user account is now blocked and advising her to contact her 
administrator. As the system administrator is currently out of the office, she contacts her colleague, David 
Kilburn, who is also a member of the Administrators group in Online Filing. 

 

Figure 17: User is blocked after three successive attempts to log on with the wrong password 

The user account can be re-activated by any user with a profile that is authorised for user administration. 

In the role of patent attorney David Kilburn, we are now going to re-activate Elizabeth Miners' user account. 

 Log on to File Manager as david with the password david. 

 Open User Administration. 

 Click the name Elizabeth Miners in the Users tab. 

The Account is disabled check box is ticked. 

 Clear the check box to remove the tick. 

 Click the Save all button. 

Elizabeth Miners' user account is active once more and she can log on to File Manager with her old password. 

 

Figure 18: Unblocking the user account 
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3.8 Activating folders for groups 

We want to enable folder management and activate specific File Manager folders for the Paralegals group to give 
all users in the group access to the same folders. 

Folder management is not enabled by default when you install Online Filing. The Folders button on the 
navigation bar in User Administration is not active. 

 

Figure 19: The "Folders" button is inactive by default in User Administration 

Enabling folder management 

 Close the User Administration window. 

 Click the System Preferences button in File Manager. 

 
-OR- 
Select Tools > Preferences > System Preferences in the Tools menu. 

 Select the check box Enable Folder Management. 

 Click Save. 

Close and restart File Manager to activate the new settings. 

 

Figure 20: Enabling folder management under System Preferences 
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Creating folders 

Next, we will create some folders in File Manager. In our example, there are three clients with patent applications 
that require administration in Online Filing. 

 Log on to File Manager with the Administrator ID. 

 Create three new folders and name them after the companies Nano Enterprise, TechEurope and Universal 
Engineering. 

 Create separate subfolders for these companies, named after specific years or individual team members, for 
instance. 

 Now create separate template folders for the three companies. 

Your screen should look like this: 

 

Figure 21: New folders created in File Manager 
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Overview of all folders 

 Open User Administration again.  

 Click the Folders button, which is now active. 

All folders that we just created in File Manager are now displayed on the right. 

All folders for the Administrators group are selected by default in the middle panel because they were created by 
the actual administrator.  

The Templates folder is always enabled for all users, which is why it cannot be deselected. However, you can 
select or exclude individual subfolders under Templates. 

The Default Folder is also always enabled for all users and is therefore not displayed for editing in Folder 
Management. 

 

Figure 22: Folders assigned to the "Administrators" group 
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Assigning folders to a group 

We are now going to assign specific folders and subfolders to the paralegals. 

In this example, we will authorise the paralegals to use the Nano Enterprise folder with all subfolders, the 
Hancock subfolder and the two template folders Nano Enterprise and Universal Engineering. At the same 
time, we will disable all TechEurope folders for this group. 

 Select the Paralegals group. 

 Select the folders that the paralegals should be authorised to access. 

 Subfolders can be displayed by double-clicking the relevant parent folder. 
 Selecting a subfolder automatically assigns the relevant parent folder as well. 
 Assigning a parent folder automatically enables all of its subfolders, including any subfolders 

subsequently created. 

 Click the Save All button. 

 
The folders assigned to paralegals are now displayed on the right. 

 

Figure 23: Folders assigned to paralegals 
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Folders activated in File Manager  

 Create a new user with the name Jennifer Hancock. 

 Add Jennifer Hancock to the Paralegals group. 

 Log on to File Manager as Jennifer Hancock. 

The folders and subfolders assigned to paralegals as well as the Default Folder and the Templates folder are 
now displayed. The TechEurope folder and the Kilburn subfolder, however, are no longer visible. 

Paralegals are authorised by the User Administration settings to create new folders. 

 Create a new subfolder called Hancock_2008 in the Universal Engineering folder.  

All other users who are already authorised to access the Universal Engineering folder will subsequently also 
be able to access this new folder. 

 

Figure 24: New folder created by a user from the Paralegals group 
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4 Workflow and privileges 

Objective 

We are going to log on to Online Filing in various user roles to see which operations are permitted by the relevant 
profiles. 

Step by step 

 We will create a new application as a paralegal and save it as a draft. 

 We will try to change the status of this application as an assistant. 

Workflow concept 

The Online Filing software tracks the workflow. In other words, it checks all tasks relating to the processing of an 
application for correctness and completeness. Depending on which tasks have been completed, applications are 
automatically assigned to one of the following statuses: Draft, Ready to Sign, Ready to Send or Sent.  

User privileges for workflow operations 

Users may only change the status of a selected application if they have been assigned sufficient privileges in the 
User Administration. 

In this example the Assistant Profile has been assigned the Send Application privilege. Sending the 
application to the EPO server changes the status of the file from Ready to Send to Sent. 

 

Figure 25: Assistant with "Send Application" privilege 
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However, according to the privileges shown in the above profile, assistants are not authorised to move an 
application from Draft to Ready to Sign status. 

This is what we are going to demonstrate in this exercise. 

Log on as paralegal Jennifer Hancock and create a new application with Form EP(1038E).  

 Select Default Folder as the storage location because this is the only location activated for assistants. 

 Process the application further and save it. 

For example, just enter an EP application number such as 08000100.1 and an annotation to the EPO. 

 Log on in the role of assistant Elizabeth Miners. 

 Click Default Folder and select the application created by Jennifer Hancock. 

 Click the Next workflow button, which is now active. 

An appropriate message appears. 

 

Figure 26: Message that appears after a user tries to perform an action without appropriate rights 
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Workflow stages for application submission  

This example shows the application passing through all the workflow stages, from the initial Draft status to the 
final Sent status. 

 The paralegal creates a new application, processes it and moves it to Ready to Sign status. 

 As the paralegal does not have signing privileges, an attorney digitally signs the application with his or her 
smart card and then moves the application to Ready to Send status. 

 The assistant is then allowed to send the applications to the EPO. This is only possible after the patent 
attorney has moved the applications to a folder assigned to the assistants. 

 Online Filing automatically saves the acknowledgment of receipt in the database without any further user 
intervention. 

 

Figure 27: Workflow stages for application submission 
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5 Importing contact details into the Address Book 

Objective 

In this section we are going to import contact details from an Office application into the Online Filing Address 
Book. In our office, it is the assistant Elizabeth Miners who manages the Address Book. We will therefore log 
back on to Online Filing in this role. 

In our example we will use Microsoft Excel 2007 and Microsoft Access 2007 with the Windows Vista operating 
system to create a CSV file (CSV = comma separated values). You can of course use any previous versions of 
Excel or Access as well as any other commercially available spreadsheet software to export your data in CSV 
format. 

Step by step 

 We will save our contact addresses from a Microsoft Excel table as a CSV file. 

 From our address database in Microsoft Access we will export a specific table and save it as a CSV file. 

 We will import the CSV file into the Online Filing Address Book and assign the field names from the CSV file 
to the field names in the Address Book. 

Sample CSV file 

In a CSV file each address is stored in a new row. The individual data fields - e.g. surname and first name - are 
separated by delimiters (e.g. commas or semi-colons). The column headings or field names are entered in the 
first row of the CSV file and are also separated by delimiters. 

In this example the Type field is used to distinguish between natural and legal persons. The English terms 
"natural" for natural person and "legal" for legal person should be used so that the data can be imported into 
Online Filing. If a row in the address file does not contain such a standardised term in the Type field, the default 
when importing into the Online Filing Address Book is "legal". 

In Windows Notepad you can show a CSV file as simple text. In our example commas are used as separators. 

 

Figure 28: CSV file in Windows Notepad 

In Microsoft Excel the same data fields appear as cells in a table. 

 

Figure 29: CSV file opened in Microsoft Excel in table view 
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5.1 Saving Microsoft Excel as a CSV file 

 The XLS file format is compatible with earlier versions of Microsoft Excel (Excel 97-2003). The XLSX format, 
however, can only be read by Office Suite 2007 applications. If you use different versions of Microsoft Office in 
your company, we therefore recommend that you save your files in XLS format. 

 Open the Excel file, which in our example is contacts.xls. 

The workbook contains three sheets: contacts_2008, contacts_2007 and contacts_2006. 

 Select the sheet you want to export, in our example contacts_2008. 

 Select Save As > Other Formats from the main menu. 

 

Figure 30: "Save As" menu in Microsoft Excel 

 In the Save As window locate the folder where you want to store your file. 

 Change the file name to contacts_2008.xls. 
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 Scroll down the Save as type list and select CSV (Comma delimited) (*.csv). 

 

Figure 31: Saving Excel table in CSV format 

 Click Save. 

 Click OK in the ensuing message to save the selected sheet in CSV format (contacts_2008 in this 
example).  

 

Figure 32: Only the active sheet in the workbook is saved 

 Click Yes to confirm that you wish to change the file format to CSV. 

 

Figure 33: Saving the CSV file in Microsoft Office Excel - confirmation of save 
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The file is now saved as contacts_2008.csv. 

 The other sheets are still visible at this point but will have disappeared the next time you open the CSV file. 

 

Figure 34: File saved in CSV format 
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5.2 Saving Microsoft Access as a CSV file 

 The MDB file format is compatible with earlier versions of Microsoft Access (Access 2000 to 2003). The 
ACCDB file format, on the other hand, can only be read by Office Suite 2007 applications. We therefore 
recommend saving in MDB format as Access 2000 or Access 2002-2003 database if you use different versions 
of Microsoft Office in your company. 

 Open the Microsoft Access database (file format MDB). In our example this is clients.mdb in Access 2002-
2003 file format 

Access databases normally contain multiple tables. 

 Open the table clients_2008. 

 Click External Data in the toolbar, then select the option Text file in the tool set for Export. 

 

Figure 35: Exporting from Microsoft Access into a text file 
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The Export - Text File window opens. 

 Click Browse next to File name to change the destination folder and file name for the save. 

 

Figure 36: Entering name for export of CSV file 
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The File Save window opens.  

 Select the folder you require from the list under Save in. 

 In the File name field type in the file name required together with the file suffix .csv. In this example you 
should enter clients_2008.csv. 

 Click Save. 

 

Figure 37: Selecting folder and file name for export file 
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 In the Export - Text file window click OK. 

The Export Text Wizard opens. 

 Tick the Delimited option. 

In the preview you will see that commas are being used as delimiters. 

 You can change the type of delimiter in the following step. 

 Click Next. 

 

Figure 38: Export Text Wizard in Microsoft Access - selecting the "delimited" option 
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 Select Semicolon as the delimiter that separates your fields. 

 Select the option Include Field Names on First Row. 

 Select {none} from the list in the Text Qualifier field. 

 Note how the data in the preview field change. 

 Click Finish. 

 

Figure 39: Finishing the Export Text Wizard 

The file has now been saved in CSV format and can be imported into the Online Filing Address Book. 
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5.3 Mapping imported field names to the Address Book 

In this exercise we will import the data for our contact addresses which we previously stored in the CSV file 
contacts_2008.csv. 

When CSV files are imported into the Address Book, column headings which are exact matches for the field 
names in Online Filing are automatically mapped to one another, provided that the column headings are in 
English.  

 Click the Address Book button in the toolbar. 

 
 Select File > Import in the Address Book. 

 Select the file contacts_2008.csv and click Open. 

Online Filing numbers the heading names in the CSV file and maps all exact matches.  

If Online Filing does not find an exact match for the Address Book field, the CSV File Field indicates None. 

In the following step we will map the CSV file fields to the fields in the Online Filing Address Book (drag the 
bottom edge of the window down to see all fields, if required). 

 

Figure 40: Fields in CSV file to be imported not yet mapped to fields in the Address Book 

In our example the Address Book fields First Name, Title, Country and Region are mapped to the corresponding 
fields in the CSV file because they happen to have the same name. 
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We now need to map all the remaining field names. 

 Double-click on the white space containing the word None next to the Address Book Field labelled Person 
Type in the first row. 

This will open a drop-down list of available CSV column headings. 

 In the drop-down list select Type for the CSV field. 

 

Figure 41: Mapping fields, selecting field in CSV file 

 Repeat this process to map the CSV field name Name to the Address Book field Last Name. 

 Continue for all other fields. 

 If a field in the Address Book does not have a corresponding field in the CSV file, leave it as None. You can 
always add the data manually at a later date, if required. 

 Click OK when you are done. 

 

Figure 42: Mapping field names for Address Book completed 
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The import process is now started. If the software finds a duplicate name in the Address Book a prompt appears. 

 

Figure 43: Prompt for existing Address Book entry 

 Click Overwrite to replace the existing name with the imported data. If the software finds a further duplicate 
name, you will be asked again how you wish to proceed. 

 Selecting Overwrite all will replace all existing duplicate names at once. 

 Click Skip if you do not wish to import a particular duplicate name. You will be prompted again if the software 
finds a further duplicate name. 

 Click Skip all if you do not wish to import any of the duplicate names. 

 Click Add as new Record to import the duplicate name as a new entry in the Address Book. 

 If no person type (either natural or legal) is indicated for a record, a legal person type is assumed by 
default. 

 At the Import complete prompt click OK. 

 

Figure 44: Import of data into Address Book complete 
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6 Editing routes, roles and registration numbers 

Objective 

In this section we are going to enter data for multiple routes, roles and registration numbers for a natural person 
whose details are stored in our Address Book. Multiple registration numbers may be entered manually or 
imported from a CSV file. 

Step by step 

 We will enter multiple routes, roles and registration numbers as the representative for a person. 

 We will import a person with multiple registration numbers as an applicant. 

 

Entering multiple routes and registration numbers manually 

In this exercise we will log on in the role of assistant Elizabeth Miners and add missing data for Jennifer Hancock. 

 1st role: Route = EP, Role = Representative, Registration No. = 1234567.4 

 2nd role: Route = PCT, Role = Agent, Registration No. = 100123456 

 3rd role: Route = UK, Role = Party, Registration No. = 800812345 

 Please bear in mind that this is only an example. For more information about roles and registration number 
formats contact the relevant national office. 
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 From File Manager, open the Address Book by clicking the Address Book button. 

 
 Select the Address Book entry you wish to add data to, in this example Hancock, Jennifer. 

 Click the New button above the Route | Role | Registration No. headings. 

 
When you click the New button EP automatically appears under Route, and Applicant under Role. The 
role needs to be changed. 

 Double-click the Role and change it to Representative. 

 Double-click the Registration No. field and enter the registration number 1234567.4. 

 Click the New button again to create the second line. 

 Select PCT as the Route and Representative as the Role. 

 Enter the registration number 100123456. 

 Click the New button to create the third line. 

 Select UK as the Route and Party as the Role. 

 Enter the registration number 1800812345. 

 Click the Save All button. 

 

Figure 45: Multiple registration numbers entered manually 
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Importing route and registration numbers from a CSV file 

In our example, there are two data sets in the CSV file for Salvatore Manzoni, a natural person. One is 
EP|Applicant|155668895 and the other is PCT|Applicant only|3440122388. Both sets of data are contained 
in the Role field and separated from one another by vertical bars. 

 Please bear in mind that the CSV file uses different names for roles depending on the route, in other words, it 
uses Representative in the EP procedure, Agent in the PCT procedure, Applicant in the EP procedure and 
Applicant only in the PCT procedure. 

 

Figure 46: Multiple registration numbers in the Procedure - Role field in an Excel table 

 Log on to File Manager as an administrator. 

 Import the CSV file into the Address Book as described in the last section's exercises. 

The imported data for Salvatore Manzoni looks like this in the Address Book: 

 

Figure 47: Example of an imported Address Book entry with multiple registration numbers 
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7 Creating templates with user-specific standard data 

Objective 

In this exercise we are going to create and modify a template for our applications. For this operation, we will log 
on to Online Filing in the role of patent attorney David Kilburn. 

Step by step 

 We start by creating a new template for the procedure EP(1001E2K). 

 We enter all the details for reuse. In our example these are the Filing Office, Applicant, Representative 
and Fee Payment details. 

 The data for our applicant, Universal Engineering, is already stored in the Address Book, so we can use it 
for our draft. 

 We can also use the data on the representative, David Kilburn, that is stored in the Address Book. 
 We change the fees selected and provide information about the mode of payment and the deposit 

account. 

 We save the template. 

 We will then open the template in order to change the name of the representative. 
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7.1 Creating a new template 

We have already created an individual template folder for Universal Engineering's templates. We are going to 
use this subfolder for our new template. 

 Log on to File Manager in the role of patent attorney David Kilburn. 

 Select New Template in the File menu or press SHIFT+CTRL+N. 

 Enter UnivEng_EP as the template name. 

 You can use the Group field to assign the template to the possible procedure groups. These are EP and 
PCT in the default installation. 

 Select EP(1001E2K) from the Procedure list.  

 Select English as the Language of proceedings. 

 Select the Universal Engineering subfolder. 

 Enter the following brief description: EP filings for Universal Engineering. 

Your screen should look like this: 

 

Figure 48: Creating a new template 

 Click Create. 

An empty Form EP(1001E2K) opens with the new template. 
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7.2 Selecting the filing office 

 In the Request tab, enter EP in the Filing Office field. 

The full name for the European Patent Office is completed automatically. 

 We do not enter a Title of Invention. 

Your screen should look like this: 

 

Figure 49: Selecting the filing office 
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7.3 Entering the applicant's name 

 In the Names tab click the Add button and select Applicant, Legal. 

 
In our example the applicant is Universal Engineering. 

 The company's data are already in the Address Book, so in the Names tab click the Copy from address 
book button. 

 
 In the Address Book select the name and click the Copy records to form button. 

 

 Note that legal persons are indicated by the icon  . 

Your screen should look like this: 

 

Figure 50: Applicant (legal person) data copied from Address Book 
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7.4 Entering the representative's name 

 In the Names tab click the Add button and select Representative, Authorised. 

In our example the representative is David Kilburn. 

 David Kilburn’s data are already in the Address Book, so in the Names tab click the Copy from address 
book button. 

 
 In the Address Book select the name David Kilburn and click the Copy records to form button. 

 

 Note that natural persons are indicated by the icon  . 

Your screen should look like this: 

 

Figure 51: Representative data copied from Address Book 
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7.5 Entering the details for fee payment 

In this section we are going to enter the payment details for IP Partners, but without specifying the fees. 

 In the Fee Payment tab click the Fee selection sub-tab and clear all the check boxes. 

 Click the Payment Details sub-tab and select Debit from deposit account as the Mode of payment. 

 Enter the deposit account information, e.g. 28123456 for the Deposit account number and IP Partners for 
Account holder. 

Your screen should look like this: 

 

Figure 52: Selecting mode of payment and providing details of deposit account 

 

7.6 Saving the template 

 Select File > Save from the menu. 

The template is kept opened in the form view. 

 Close the template and select the option Exit without saving. 

The template now appears in the Universal Engineering folder under Templates in File Manager. 
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7.7 Editing a template 

In this example the previous representative, David Kilburn, has left the company. 

We will log on as an administrator and add the former paralegal Jennifer Hancock to the Attorneys group. We 
will leave David Kilburn's username but we will change his password as a precaution and remove this user from 
all groups, leaving him without any user rights in Online Filing. 

We will then change the template to reflect Jennifer Hancock as the new representative for future operations. We 
will transfer Jennifer Hancock's data from the Address Book. 

 Double-click the Templates folder in the File Manager in order to display the subfolders. 

 Select the templates folder Universal Engineering. 

 Right-click the template UnivEng_EP and select Edit template from the shortcut menu. 

The template opens in the form view, ready for editing. 

 

Figure 53: Opening template for editing 
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 In the Names tab select the current representative, David Kilburn. 

 Click the Copy from address book button. 

 
 In the Address Book select the name Hancock, Jennifer and click the Copy records to form button. 

 
Your screen should look like this: 

 

Figure 54: Changing representative data in template and copying to Address Book 

 Close the template and select the option Save and exit. 

The template has been saved together with the new data. Applications drafted using the previous template with 
David Kilburn as the representative are not affected by these changes. You will have to change the name in 
these applications if they are not yet in Sent status. 

 It is not possible to edit the type of procedure in the template. 
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8 Completing an application with form EP(1001E2K) 

Objective 

In this section we will use the Online Filing software to create a new application based on Form EP(1001E2K), 
enter the mandatory data and move the application from Draft to Ready to Sign status. We are going to use 
the role of paralegal Oliver Barber for this. 

Step by step 

 In our example, the paralegal uses the template created for Universal Engineering to create a new 
EP(1001E2K) application. The title of the invention is Engine Filter. 

 The template already contains details of the applicant and representative, but the paralegal still needs to add 
the inventor. 

 The paralegal also has to attach the mandatory documents provided by the applicant. These consist of two 
files: a combined PDF file for the description, claims and abstract, and a separate file for the drawings. 

 Once the application is complete, the paralegal saves the work as Ready to Sign. The patent attorney 
Jennifer Hancock will sign the application later. 



Online Filing 5.00 - Advanced Tutorials 
 

Page 54 of 104 

 

8.1 Creating an application based on a template 

Create a new draft 

 Log on in the role of paralegal Oliver Barber. 

 Double-click the Templates folder in the File Manager and select the Universal Engineering subfolder. 

 Double-click the template UnivEng_EP. 

The window Create a New Application opens. 

 In the User Reference field enter UE2008-09. 

 Double-click the folder Universal Engineering, select the subfolder Hancock_2008 and then click Create. 

 

Figure 55: Creating a new application using a template 

Entering the title of the invention 

 In the Request tab, enter Engine Filter in the field Title of Invention in English. 

 Enter the relevant terms in the fields Translation into French and Translation into German. 

 If you omit these entries, the yellow validation icon remains in the Request button. You can still file the 
application with the EPO but will have to submit the translations at a later point in time.  
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8.2 Adding inventor's details 

The inventor in our example is called Harold Stockton. Harold Stockton works for Universal Engineering.  

 In the Names tab click the Add button and select Inventor. 

 Enter the details for Harold Stockton. 

The lower part of the form contains information on the legal relationship between the applicant and inventor. The 
As employer option is selected by default. 

 Select the options Waiver by inventor of notification of information and/or Renunciation of title by 
inventor, if required. 

 Click the Copy to address book button. 

 
This creates a new entry for Harold Stockton in the Address Book. 
This is shown in the status bar at the bottom of the screen. 

 

Figure 56: Information entered on the inventor 
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8.3 Attaching the technical documents as a PDF-file 

In the Documents tab on the left there is a list of all the attached files. Our example currently contains no 
documents in this list.  

We will add technical documents in the form of a PDF file. The file contains the description, the claims and the 
abstract. 

The drawings are not included in this combined file, but rather are attached in a separate step. 

 In the Documents tab, click the Specification sub-tab and then click the Add button. 

 
 Select the option Technical document(s) in English and in the Open window navigate to the file called 

Engine filter.pdf. 

 Click Open. 

The file is renamed to SPECEPO-1.pdf. The original file name is also shown, for reference purposes. 

 Tick the check boxes for the Description, Claims, Abstract and Drawings. 

This unlocks the associated fields for editing. 

 In the Specification sub-tab next to Description enter the page numbers for the description in the PDF file 
(From page and to). In our example the description starts on page 1 and finishes on page 7.  

 Enter 10 as the Number of Claims and 8 to 9 as the page numbers for the claims. 

 In the Figure to be Published with Abstract field enter the number 1. 

 Enter the page numbers 10 to 10 to indicate where the abstract is located in the document. 

 All pages must be accounted for, and there must be no overlaps. In other words, the texts for the description, 
the claims and the abstract should each start on a new page in your combined file. 
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Your screen should look like this: 

 

Figure 57: Technical documents attached as PDF file 
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8.4 Attaching a PDF file for the drawings 

 In the Documents tab, click the Specification sub-tab and then click the Add button. 

 
 Select the Technical Document(s) in English option once again, navigate to where the Engine filter 

drawings.pdf is stored and select it. 

 Click Open to attach the file. 

In the Documents tab, the check boxes for Description, Claims and Abstract are deactivated because 
you have already attached these components of the technical documents. 

 Select the Drawings check box. 

The file is renamed to SPECEPO-2.pdf. 
 Enter 2 in the Number of drawings field. 

Your screen should look like this: 

 

Figure 58: PDF file for drawings attached 
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8.5 Saving application as "Ready to Sign" 

The application for Universal Engineering is now complete and all red and grey validation icons have 
disappeared. A yellow validation icon only remains now in the Priority button, indicating that data is missing. 

 Click the Priority tab. 

 Select the option It is not intended to file a (further) declaration of priority. 

The yellow validation icon then also disappears. 

 Select File > Close in the menu. 

 At the prompt select the option Move to Ready to Sign and exit. 
In the File Manager the file is displayed with Ready to sign status. 

Your screen should look like this: 

 

Figure 59: Application in "Ready to Sign" status 
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9 Modifying an application in a previous workflow status 

Objective 

In this section we will modify an application in Online Filing. For this operation, we will log back on in the role of 
paralegal Oliver Barber.  

Step by step 

 In our example, a paralegal has prepared a Form EP(1001E2K) application entitled Engine Filter, attached 
all documents and moved the form to Ready to sign.  

 However, the applicant has now amended the description, claims and abstract and provided them in separate 
files. 

 We will therefore remove the existing technical documents and attach the new files. 

 The file containing the drawings is correct, so we do not have to make any changes here. 

In the File Manager the ToolTip on the Next button says "Sign". Opening the application would therefore 
automatically launch the signing process. The paralegal must therefore return the application to Draft status in 
order to be able to amend it. 

 

Figure 60: Application can be signed but not modified 
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 In the File Manager click the Previous button. The ToolTip indicates "Draft". 

 

Figure 61: Clicking the "Previous" workflow button changes the status to "Draft" 

The application is reset to Draft status. 

 

Figure 62: The application is back in "Draft" status and may be moved to "Ready to sign" 
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9.1 Removing attached documents 

Before we can attach new documents, we must first remove the existing technical documents. 

 In the File Manager, double-click the application to open it in Draft status. 

 Click the Documents tab and then select the Specification sub-tab. 

 Select the file SPECEPO-1.pdf. 

 Click the Delete button. 

 
The combined file SPECEPO-1.pdf is removed. 

 

Figure 63: Removing technical documents file 
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9.2 Attaching new documents 

Now that the previous combined file has been removed, the new files can be attached. We will attach one file 
each for the description, the claims and the abstract. 

Attaching a new description 

 In the Documents tab, click the Specification sub-tab and then click the Add button. 

 
 Select the Technical document(s) in English option, navigate to the file called Engine filter 

description.pdf and select it. 

 Click Open to attach the file. 

 Tick the check box for Description. 

The file is renamed as SPECEPO-2.pdf. 
Your screen should look like this: 

 

Figure 64: PDF file for description attached 
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Attaching new claims 

 Repeat this process to attach the claims file and select the check box for Claims. 

The file is renamed as SPECEPO-3.pdf. 
 Enter 10 in the Number of Claims field. 

 Claims may be filed later if required. In this case you should select the check box The claims will be filed 
later, which is below the list of attached documents (see above). This deactivates the check box for the claims. 

Attaching a new abstract 

 Repeat this process to attach the abstract file and select the check box for Abstract. 
The file is renamed as SPECEPO-4.pdf. 

 Enter 1 in the Figure to be published with abstract field. 

Adding an internal note 

Before we finish we are going to add an internal note to let the attorney know that the corrections have been 
made. 

 Click the Internal Note button. 

 
 Click the New button and enter Oliver Barber in the Author field. 

 Enter Revised documents in the Subject field. 

 Enter The applicant's revised documents are now attached in the Note field.  

 

Figure 65: Adding an internal note for the attorney 

Saving the application as "Ready to Sign" 

Now we will return the application to Ready to sign status. 

 Select File > Close from the menu. 

 At the prompt select the option Move to Ready to sign and exit. 
In the File Manager the file is displayed with Ready to sign status. The author, date and subject of the 
internal note are shown in a summary on the lower part of the screen. 
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10 Signing and sending the application 

Objective 

The application now contains all the mandatory information and is ready for signing. In our example, we are 
going to apply a digital signature in the role of patent attorney Jennifer Hancock. We will then switch to the role of 
assistant Elizabeth Miners and send a number of completed applications to the demo server in The Hague, using 
the "batch send" functionality. 

Step by step 

 We will apply a digital signature to our application.  

 Before we sign the application we will check our personal smart card. 

 We will send all our applications with Ready to send status to the demo server in The Hague. 

 

 

10.1 Checking your smart card 

 Log on to File Manager in the role of patent attorney Jennifer Hancock. 

The Smart Card Checker tool is automatically installed together with the File Manager or the Online Filing 
client. It starts automatically when the File Manager is running. The Smart Card Checker icon and the icon for the 
smart card reader are displayed in the Windows system tray. 

 The Smart Card Checker is only available in English. 

 

Figure 66: Programme icons in the Windows system tray 

The Smart Card Checker automatically locates the correct smart card driver software on the computer and 
checks registered certificates, so that when you change from one smart card to another you do not have to carry 
out any manual changes. 

Checking your smart card 

 Insert your smart card into the reader. 

If the green light flashes this indicates that either the card was not inserted properly or it cannot be read. 

 Right-click on the smart card checker symbol in the system tray and select Check Smartcard. 

 

Figure 67: Check smart card 
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The smart card is checked. 

If there is no reader connected to the PC, if no smart card is inserted, if the smart card has not been inserted 
properly, or if it is invalid, the smart card checker indicates that the card is not recognised. 

 

Figure 68: Smart card not recognized 

If the smart card is valid and was correctly inserted into the reader, the smart card checker checks the data and 
indicates that the smart card is recognised. The green LED on the reader indicates that the smart card is valid 
and inserted correctly by shining steadily, otherwise it flashes. 

 

Figure 69: Smart card recognized 

In the next step we use the smart card to sign the application. 

 

 

10.2 Signing the application 

In the File Manager our application has Ready to sign status. The ToolTip on the Next button now displays 
"Sign", so we can sign the application in the next stage of the workflow. 

 Click the Next button. 

 
The application is displayed in the PDF-Viewer. The documents attached are listed on the left. 

 Click Sign now in the lower right-hand corner to proceed. 

 For the purposes of this tutorial, select Jennifer Ashcroft as the Representative. 

 Select Smart Card as the Type of signature. 

 If you normally use your smart card to sign applications, you can tick the Save settings as default 
check box. 

 Enter your PIN Code. 

 Enter Cambridge as the Place of Signing. 

 The place of signing is optional. 

 To finish, click Sign. 
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Your screen should look like this: 

 

Figure 70: Signing details completed 

The software checks the smart card data and generates XML files using the data from the form. This may take a 
while. The following message box is displayed while the process is running. 

 

Figure 71: Processing the electronic signature 

The Sign application window then closes automatically and the status of our application changes to Ready to 
send in File Manager. 

 At least one signature is required on each application. Whether or not you are authorised to sign forms 
depends on the user rights you were assigned by the Online Filing administrator. 
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10.3 Sending the applications 

To complete this exercise using the "batch send" functionality, we need at least two applications with Ready to 
send status. We will send all applications with Ready to send status to the demo server in The Hague. 

 Log on in the role of patent attorney Jennifer Hancock to create another application such as EP(1038E) and 
sign it. 

As soon as the application receives a digital signature, it moves to Ready to send status. 

 Finally, move the signed applications to the Default Folder because personal folders are not activated for 
assistants in File Manager. 

 Log on in the role of assistant Elizabeth Miners to send the applications. 

 Select Default Folder and click Ready to Send in the navigation bar. 

 Create a multiple selection list of the applications you want to send with CTRL+click. 

 Click the Next button to proceed. The ToolTip indicates "Send". 

 

Figure 72: Applications with "Ready to send" status selected 
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 At the warning prompt, ensure that the transmission is going to the location you intend - in this case the demo 
server. 

 Click Continue Sending. 

 

Figure 73: Sending application to demo server 

 Enter your PIN code and click OK. 

 

Figure 74: Entering PIN code before sending 

As each application is sent, a progress indicator informs you of the current stage of the transmission. 

 

Figure 75: Progress indicator 
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10.4 Viewing and saving receipts 

Objective 

In this section we will view and save copies of receipts. The assistants in our patent attorneys' firm are not 
authorised to open an application or the documents attached to it, which is why we will now log on again in the 
role of patent attorney Jennifer Hancock to check the acknowledgment of receipt.  

Step by step 

Once the transmission is complete, the applications are displayed in the File Manager with Sent status. 

 To view the attached documents (including the receipt), select an application and click the View... button. 

 

Figure 76: Applications with "Sent" status 
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 In the PDF-Viewer select the document receipt.pdf from the list of files. 

 Click the Save copy button and enter a file name for the PDF document. 

 

Figure 77: Storing receipt from the PDF Viewer. 
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11 Exporting and importing individual applications 

Objective 

In this section we will export an application into an external folder on our PC and import another application for 
processing in the Online Filing software. 

Step by step 

 We will export all sent applications as ZIP files, including all attached files, into a storage location elsewhere 
in our company's network. 

 We will import an application that was exported earlier back into File Manager to use it as a basis for a new 
application. 

Further exercises 

The chapter Exporting and importing applications with the Server Manager (p. 95) deals with exporting and 
importing applications in more detail. Managing and backing up databases is dealt with in the chapter Managing 
databases (p. 88). 

User rights for import and export 

Although Server Manager offers a comprehensive range of data management features, they can only be used by 
members of the Administrators group. A user with Administrator ID can add other users to the 
Administrators group in User Administration to grant them access to the same rights. Administrators in a 
company are responsible for managing the database as well as for exporting and archiving data. 

All other users can use File Manager functions to export or import individual applications as required, provided 
they belong to a group with an appropriate profile of privileges. 
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11.1 Exporting applications to ZIP files 

In this exercise, we will archive all sent applications in the role of patent attorney Jennifer Hancock. The Export 
Forms function generates a compressed ZIP archive for every application and at the same time enables you to 
delete the applications in the database. 

 In File Manager, select File > Export > Forms. 

 Click the sent Sent folder on the left. 

Only sent applications are displayed. 

 Click the  icon in the table header. 

This selects all applications. 

 Tick the check-box next to Delete items from database after archiving. 

 Click OK. 

 

Figure 78: Selecting the forms you want to export 

Online Filing automatically opens the directory selected in User Preferences for exporting files. In this example 
the default directory is EPO_data/Export on drive G. 

We will create a new subfolder for Universal Engineering in the Export folder. 



Online Filing 5.00 - Advanced Tutorials 
 

Page 74 of 104 

 Click the Make New Folder button. 

 

Figure 79: Selecting the folder for export 

A new folder is created. 

 Enter Universal Engineering as the name of the new folder. 

 

Figure 80: New folder renamed in export destination 

 Click OK to start the export process. 

 Close the Export complete message by clicking OK. 

The applications are then deleted in File Manager. 

The new Universal Engineering folder can now be found in the Export folder and contains the ZIP files that 
Online Filing created and that were automatically renamed by the software as UE2008_08D.zip and 
UE2008_09.zip based on the file reference of the applications.  
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The ZIP file UE2008_09.zip contains multiple PDF and XML files. The file ep_request.pdf contains Form 
EP(1001E2K) and the application. SPECEPO-1.pdf contains the description, SPECEPO-2.pdf the drawings, 
SPECEPO-3.pdf the claims and SPECEPO-4.pdf the abstract. The acknowledgement of receipt is saved as 
receipt.pdf and the designation of inventor as F1002-1.pdf. 

 

Figure 81: Applications and all associated files in the exported ZIP archives 
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11.2 Importing an application from a ZIP file 

The team at IP Partners regularly archives sent applications and deletes them from the database. The system 
administrator moves the ZIP files from the Export folder to an archive folder. 

In this example, patent attorney Jennifer Hancock is going to use Form EP(1038E) to submit other documents for 
the Universal Engineering application already sent. She needs data from the archived application for this and will 
import it back into File Manager.  

 Select the folder Hancock_2008 as the exact location in File Manager where you want to place the imported 
application. 

 In the menu select File > Import > XML from File. 

The software automatically opens the directory selected for import in User Preferences, which in our 
example is the EPO_data/Import folder on the G drive.  

 Go to the Archives folder and open it with a double-click. 

 Select the file UE2008_09.zip then click Open. 

 

Figure 82: Selecting ZIP file containing application to be imported 
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The Create a New Application window opens. 

 Enter a UE2008_09A as the User Reference for the new application. 

 The subfolder Hancock_2008 should already be selected. 

 Click Create. 

 

Figure 83: Creating a new application from imported data 

The new application opens in the form view as a draft. 

 Close the application using the Save and exit option. 
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The application is now stored in Draft status in the subfolder Hancock_2008, within the Universal 
Engineering folder and can be processed further as required. 

 

Figure 84: Imported application in "Draft" status in the File Manager 
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12 Managing servers and services 

Objective 

We are going to log on in the role of administrator to use Server Manager to manage the server and Online 
Filing's active services. 

Step by step 

 We will familiarise ourselves with the functions of the Server Manager. 

 We will use the Server Manager to start and stop services for the File Manager and the various Online Filing 
procedures. 

 We will determine which directories in our computer network can be accessed by the Server Manager. 

 We will define settings for the Live Update mechanism. 

 

 

12.1 Server Manager - Overview 

The Server Manager allows Online Filing users to administer and manage the Online Filing servers, services and 
databases in their office network.  

The Server Manager is automatically installed together with Online Filing (Version 4.00) when Local 
Installation or Server Installation is selected during the setup. 

Starting Server Manager 

Like the Online Filing client (File Manager), Online Filing Server Manager is started in Windows XP, Windows 
2000 or Windows 2003 Server by simply clicking the link in the Program menu.  

Proceed as follows in Windows Vista: 

 Go to the Windows Start menu and select: Programs > EPO Online Filing > Online Filing Server 
Manager. 

 Right-click the link Online Filing Server Manager. 

 Select Run as administrator in the shortcut menu. 

If you are not the Windows administrator, you must now enter his or her Windows password. 

 Click Allow in the User Account Control window (Windows Vista). 

The Server Manager login window appears. 
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User mode in Server Manager 

Production mode is the only option available when you log on to Server Manager. You can only log on to 
Server Manager if you are the user named Administrator or a user from the Administrators group. 

 

Figure 85: Logging into Server Manager in production mode 

Server Manager - Overview 

The Server Manager's most important features can be accessed via the following eight tabs. Server Manager 
always opens in the Services tab. 

Feature Comments 

Services Control services: monitor, stop and start Online Filing services. 

Backup Backup, restore and clear the complete database. 

Export Export items from the database, e.g. applications or templates, and store them as ZIP 
files. Deleting items after export is optional. 

Import Import items into the database that have been previously exported, e.g. applications or 
templates, to use them in File Manager. 

Users Monitor and manage users logged in to Online Filing. 

Unlock Disconnect users from items in the database, so that the respective record 
(application) in the database becomes unlocked and, hence, editable for other users. 

History List of user activities in File Manager and the other services, with IP addresses, 
Windows account names and OLF user names. 

Settings Define default file locations for backup, import and export. 

Define settings for Live Update and perform a live update. 

 

 The Export, Import and Unlock functions are not available for data in the demo mode database. 
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12.2 Services management 

The Services tab allows users to monitor and manage Online Filing services. 

The list shows all installed services by Plugin name, Exe file name (path to the programme file), Service 
name, Status, CORBA port, SOAP port and Connections (number of active user connections). 

 Click the Refresh button. 

This will display the current status of all services in the Server Manager.  

In the example below, the service EPO OLF EP122K has been stopped.  

We will restart the EPO OLF EP122K service and then stop the EPO OLF EP2000 service. 

 Stopping/starting the File Manager (EPO OLF File Manager) will stop/start all other online services at the 
same time. 

 

Figure 86: Services in active state 
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Starting a service 

 Select the EPO OLF EP122K service - the current status is Stopped. 

 Click the Start as service button. 

The EPO OLF EP122K service is started, and users can once again work with the procedure Euro-
PCT(1200E2K). 

 

Figure 87: Restarting service in Server Manager 

Stopping a service 

 Select the EPO OLF EP2000 service - the current status is Running. 

 Click the Stop button. 

The EPO OLF EP2000 service is stopped and all active users are disconnected. 

 

Figure 88: Stopping a service 
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12.3 Settings for file locations 

The Settings tab allows you to define default directories for Backup and Restore, Export and Import. Only 
files located in these specific directories are offered for the selected function. 

Setting Comment 

Backup and restore directory Location for storing database backup files. 

Export directory Location for exporting applications as ZIP files. 
For production mode only. 

Import directory - source Default location from which ZIP files are imported as new 
applications. 
For production mode only. 

Import directory - destination Default folder in the File Manager where imported applications are 
created. 
For production mode only. 

 

Changing directory settings 

We will change the directory settings, so that data are no longer stored in the directory 
EPO_OLF5\tools\smanager\data. The default setting uses the path created when the Online Filing 
programme files were installed. 

 Click the folder button to the right of the directory path for Backup and restore. 

 

Figure 89: Default settings in the Server Manager 
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 Navigate to the new directory in your computer/network drive. 

 Click OK. 

 

Figure 90: Setting backup and restore directory 

 Repeat this procedure for the Export and Import directories. 

 Then change the default folder for imported applications in the File Manager. 

 

Figure 91: Setting default folder for imported applications 

The new directory paths are now displayed in the Settings tab. 

 

Figure 92: Folder settings in Server Manager changed 
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12.4 Setting up Live Update 

Objective 

We are going to set up the Live Update and check whether there are any changes on the EPO's update server 
that are relevant to our installation of the Online Filing software. 

Step by step 

 We will enter the settings for connection to the Live Update server.  

 We will activate the automatic Live Update mechanism. 

 We will check if there are any updates available in manual mode. 

 We will select the specific countries for which Live Update should search for updates of national procedures. 

Update types 

Live Update performs three different types of update. 

 Maintenance: Changes in the maintenance tables, such as countries, languages, fees, URLs, addresses. 
The relevant maintenance tables are automatically updated as soon as you download the update when 
starting File Manager. 

 Patch: Changes to the existing software, new features, new national routes. 

 Installation: New version of the Online Filing software released following a complete revision.  

Instead of installation via Live Update, you can also download all updates as installation files (EXE files) via the 
Download Centre on the EPO Online Services website (http://www.epoline.org). 

Network settings for Live Update 

If your networked workstation is connected to the Internet via a proxy server, you can enter the settings required 
for connection to the EPO server under Live Update proxy. 

 Contact your system or network administrator for information about the correct setting. 

 Open the Settings tab in Server Manager. 

The Live Update options are on the lower part of the screen. 

 Enter the IP address or the computer name of the proxy server in the Server field. 

 Enter the port number assigned to Live Update in the proxy server in the Port field.  

 Enter a username in the Username field and the associated password in the Password field if this is 
required by your proxy server. 

http://www.epoline.org/�
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! Warning: The username and password for the proxy user are saved in unencrypted form in the file 
OLFfm.conf. As a result, these credentials should NOT be identical to your Windows access. 

 

Figure 93: Settings for Live Update 

Activating automatic Live Update 

 Select the check box Enable software update system in the Settings tab. This option is normally selected 
by default. 

The option Check for update every ... day(s) is set to 1 (day). You may change this if you wish. 

From now on, the Online Filing software will always run searches at the set intervals. 

Running Live Update manually 

 To run Live Update immediately, click Check now. 

If new updates are found, a prompt appears with a list of the updates available. 

 Select the updates you wish to install and click Download. 

Online Filing verifies the downloaded data. 

 Click OK in the message. 

 The Install button activates. 

 Stop all Online Filing services in Server Manager before you install the updates. 
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Selecting countries for Live Update 

The countries for Live Update are selected in File Manager. 

 Log on to File Manager as an administrator. 

 Click the System Preferences button. 

 
-OR- 
Select Tools> Preferences > System Preferences. 

 In the Online Services File Manager section to the left click Countries. 

 Tick or clear the check boxes for the countries you wish to include in/exclude from Live Update. 

 Click Save. 

 The File Manager must be closed and restarted in order to activate the new settings. 

 

Figure 94: System Preferences - selecting countries for Live Update 

 



Online Filing 5.00 - Advanced Tutorials 
 

Page 88 of 104 

 

13 Managing databases 

Objective 

In this section we will create backups of the Online Filing databases and restore a database from a backup file. 
We will then delete old applications from a database. 

Step by step 

 We will create a backup copy of the demo database and a backup of the production database. 

 We will restore the demo database using an old backup copy. 

 We will empty the production database, whilst retaining important data. 

 

Overview of database and backup functionalities 

The Server Manager's backup functionalities allow you to back up, restore and clear the entire database. 

The Backup tab displays a list of all existing backup files stored in your default backup directory (see "Settings 
for file locations" p. 83). The list also includes the database Type (Demo or Production), plus the File name and 
File date of the backup files. 

 
Backup Back up the complete Online Filing database to a ZIP file. 

 
Restore Restore the database from a selected backup file. 

 
Delete file Delete a backup file. 

 
Empty database Empty the database and create a new one.  

 
Refresh Update list of backup files from the default backup directory. 

 

Figure 95: List of backup files in the backup folder 
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13.1 Backing up databases 

The backup function should be used regularly to save all users' data in a physical location other than the hard 
drive used by the server. Backup is available for both demo and production mode. 

We will now create a backup copy of the demo and production databases and store it in the backup directory. 

 Click the Backup tab. 

 Click the Backup button to start the backup process. 

 
If users are connected to the system, you will be prompted to disconnect them first. 

 

Figure 96: Prompt to disconnect all users 

 Select the Demo database option. 

 Click Start. 

 

Figure 97: Selecting demo database for backup 

The database will be backed up and stored in the default backup directory. 

 Click OK when the Backup complete prompt appears. 

 Repeat the process for the Production database. 
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Your screen should look like this: 

 

Figure 98: New backup files created from demo database and production database 

Backup files are stored in ZIP format. The file names consist of the date on which they were created, the exact 
time (down to the second) and the database mode (demo or prod) as follows: 
YYYYMMTT_hhmmss.mode.zip. For example, the file name 20080909_170804.demo.zip indicates that 
the backup file was created on 09.09.2008 at 17:08:04 hrs from the demo database. 

 Applications previously moved to the Trash folder in the File Manager will not be included in the database 
backup. They therefore cannot be restored at a later date. 

Deleting backup files 

From time to time you should delete any backup files that you no longer require, in order to clear disk space. 

 Click the backup file in the list that you want to delete. 

 Click the Delete button. 

 
 Confirm that you want to delete the file by clicking Yes. 

 

Figure 99: Prompt to delete backup file 
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13.2 Restoring databases 

If you have to reinstall the Online Filing software, for example following a system crash, you can restore your 
data from a backup copy of the database. 

Backup copies of the production database can only be restored to the production database, and backups of the 
demo database can only be restored to the demo database. The software only ever offers suitable options. In 
other words, it will never let you restore a backup of the production database to the demo database or vice versa. 

! Caution: The Restore function completely overwrites the selected database and restores the 
status that existed when the backup copy was created. All applications created in the meantime 
and all changes in applications and templates, the Address Book and User Administration are lost. 

Restoring the demo database 

We are now going to restore the demo database of September 09, 2008. 

 Click the Backup tab. 

 Select the required backup file from our list.  

In this example we will use 20080909_1708048.demo.zip. 

 Click the Restore button. 

 

Figure 100: Selecting backup file to restore the demo database 
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 In the Restore logging prompt, click Start. 

 

Figure 101: Restore logging prompt 

Once the restore process is finished successfully, the following message appears. 

 Click OK to continue. 

 

Figure 102: Restoring of demo database done successfully 

Restoring the demo database 

When restoring the production database, the Restore logging window is followed by an additional prompt 
asking if you are sure you want to overwrite the existing database. 

 Click Yes to overwrite all data in the database. 

 

Figure 103: Warning before restoring the production database 
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13.3 Emptying databases 

Emptying the database creates a new database and deletes any data in the existing database. When emptying 
the production database, you can specify which data should be transferred from the old database: 

 All users, groups, profiles and mappings 

 Templates 

 Address Book 

 All applications in Draft, Ready to sign and Ready to send status, i.e. all applications which are NOT in Sent 
status.  

! Warning: Sent applications are always deleted when you empty the database. Use the Export 
function if you want to archive sent applications before you empty the database. Select all sent 
applications for export. 

 

We will empty the production database and transfer all data, excluding sent applications, into the new database. 

 Click the Backup tab. 

 Click the Empty button. 

 
If other users are currently logged on to Online Filing, a message appears prompting you to terminate these 
user connections before proceeding. 

 Select the Production database option.  

The extended options are selected as default. 

 All extended options apply to the demo database by default. 

 Click OK to continue. 

 

Figure 104: Selecting data to transfer to new database 
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 Click Yes in the Question prompt to confirm that you want to empty the database. 

 

Figure 105: Prompt to confirm that the production database should be emptied 

The active services are terminated and the database is compressed. 

 

Figure 106: Compressing the database 

The services are restarted after you create the new database. 

 

Figure 107: Restarting services after emptying the database 

A message finally appears and confirms the production database was successfully emptied. 

 Click OK. 

 

Figure 108: The production database was successfully emptied 
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14 Exporting and importing applications with the Server Manager 

Objective 

We will export all applications which have a particular workflow status in the File Manager. We will then re-import 
other applications which have previously been exported with a particular status, for further processing in the File 
Manager. 

Step by step 

 We will export from the Server Manager all applications with Draft status.  

 We will import with Server Manager all the applications with Ready to send status which are already in our 
default import directory. We will then open the File Manager to work on these imported applications. 

 

 

14.1 Exporting applications and templates 

The Export tab shows all the applications and templates stored in the Online Filing database by all the users in 
your system. Export stores applications and templates as individual ZIP files that contain the XML files and PDF 
documents generated by the Online Filing software. 

 The export functions in the Server Manager correspond to the export functions in the File Manager and can 
only be used for data created in production mode. 

Exporting all applications from a selected folder 

In this exercise we are going to export all applications with Draft status. 

 Click the Export tab. 

 The All Applications and Templates folders from File Manager are shown on the left. The folders 
Drafts, Ready to sign, Ready to send and Sent filter the list of applications based on the relevant 
workflow status. 

 The list on the right shows the content of the selected folder or all applications in the selected workflow 
status, just like in File Manager. 

 Click the Drafts folder on the left. 

 Click the  icon in the list header to select all applications. 
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 Click the Export button to start exporting files. 

 

Figure 109: Selecting all applications with status "Draft" for export 

Each application is stored as a separate ZIP file in the default export directory which you specified in Settings. If 
an application named with an identical user reference has already been exported at an earlier date, you will be 
asked if you want to overwrite the existing ZIP file. 

 Click Yes to confirm. 

 

Figure 110: Prompt for overwriting existing ZIP files during export 

Deleting items from the database 

During the export process you can opt to delete exported items from the database. 

 Tick the check box for the Delete items from database after archiving option. 

 Click the Export button. 

 
The selected items will be permanently deleted from the database. If you need to retrieve them, use the Import 
function in the File Manager or in the Server Manager. 
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14.2 Importing applications or templates 

The Import tab shows all the applications and templates available in the default import directory. The Server 
Manager reads the ZIP files that have been created during export by the File Manager or the Server Manager, 
including the original attachments. 

 Like Export, Import works for applications and templates created in production mode only. 

Importing all applications from a selected folder 

We are going to select and import all applications with Ready to sign status from our default import directory. 

 Click the Import tab. 

 Click the Ready to sign folder on the left in order to display only applications with this status. 

 Click the  icon in the list header to select all applications in the folder. 

 Click the Import button. 

 

Figure 111: Selecting all applications with "Ready to send" status for import 

The ZIP files are unzipped and imported into the database. This may take a few moments. 

! Warning: All imported applications are placed in Draft status. A special warning is not output if the 
applications imported have the same user reference as applications already in the database. 
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 Click OK in the message that confirms the import is complete. 

 

Figure 112: Import complete, imported applications have "Draft" status 

In the File Manager you will find the imported applications in the default import directory specified in Settings. In 
our example this is Applications_2008. 

 Click the Applications_2008 folder. 

 Click the Draft button to view the applications you have imported. 

You can open these applications to work on them and then move them to the required status. 

 

Figure 113: Imported applications in the File Manager in "Draft" status 
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15 Managing user sessions and connections 

Objective 

We will monitor which users are logged into Online Filing and we will disconnect user sessions. We will then 
unlock an application which has been locked by a particular user. 

Step by step 

 We will log on to Online Filing in several roles simultaneously. 

 We will check user connections to the various services in the Server Manager. 

 We will terminate user sessions. 

 We will unlock a locked data record. 

 We will review the session log. 

 

 

15.1 Managing and terminating user sessions 

The Users tab shows the users who are currently connected to the Online Filing server. 

Individual users can open multiple connections to the server: starting the File Manager, opening applications and 
processing templates. In a server installation, all Online Filing plug-ins, e.g. EP(1001E2K), run as individual 
services to which users can connect when working on an application in the relevant procedure. 

Viewing user connections 

In our scenario, two young representatives from the USA - Patricia Baxter and Alex Haselmere - are on a 
placement with IP Partners. Both want to specialise in European patent law and are therefore also going to work 
with Online Filing. 

We will create usernames for the two trainees and log on to Online Filing in their role. 

 Log on to File Manager as an administrator.  

 Create a new username for Patricia Baxter and Alex Haselmere. 

 Add the two users to the Paralegals group. 

 Log on to Online Filing as Alex Haselmere and Patricia Baxter at the same time - where possible at different 
client PCs in your network. 

 Create and save a new application using a procedure of your choice in both of these roles. Do not close 
these applications. 

 Now, log on to Server Manager as an administrator (leaving all other Online Filing windows open). 

 Click the Users tab. 
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The list on the left shows all individual connections with the services' plugin name and the user's session ID. 
The User info column shows the IP addresses of the computers and the Windows user accounts that the 
networked users entered to log on (Windows domain) as well as their usernames in Online Filing (OLF login). 
Active is shown in the State column, indicating that the user connection is live. 

 

Figure 114: Users logged in to Online Filing services 

Functionalities for user sessions 

Button Function Description 

 
Get user log Display login information for a selected user in the right-hand panel. 

 
Get full user log Display more detailed information about the logged-in user. 

 
Terminate user Disconnect user from server. 

 
Refresh Update current user list of connected users. 
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Terminating user sessions 

Before creating a backup copy of the database we will disconnect active users from the Online Filing server. We 
will start by terminating user Patricia Baxter's connection to the File Manager. 

 On the left, click the user session EPO OLF File Manager with Patricia Baxter as OLF login. 

 Click the Terminate user button. 

 

Figure 115: Terminating user session 

In the file manager, user Patricia Baxter receives a message from Online Filing informing her that she has 
been disconnected from the server. 

! Warning: All changes since the last save are lost. 

 Click OK.  

File Manager then closes and can be restarted. 

 

Figure 116: Message in the File Manager - Connection to server lost 

Closing File Manager does not clear down the user connections to the individual services, e.g. for the procedures 
EP(1001E2K) and EP(1200E2K). 

 Terminate all other user connections one at a time, including the administrator's connections. 
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15.2 Unlocking records 

The Unlock tab displays a list of all database records currently blocked by the users. 

Unlocking database records 

User Alex Haselmere has opened an application to work on, but has had to leave his desk. In the meantime, 
another employee of IP Partners wants to open the application in the File Manager but gets the following 
warning: 

 

Figure 117: Form locked by user 

 Click the Unlock tab. 

The Server Manager lists information for each record about the Plugin name (service for selected procedure), 
Session ID (internal user number), Table (table in database) and Record (internal number of data record). The 
User info column shows the IP address of the computer and the Windows user account that the networked user 
entered to log on (Windows domain) as well as his or her username in Online Filing (OLF login).  

In our example, Alex Haselmere is logged in to Form EP(1038E) and the Administrator is logged in to Form 
EP(1001E2K). 

 Select the data record with Form EP(1038E) which is blocked by Alex Haselmere. 

 Click the Unlock button. 

 

Figure 118: Unlock form blocked by user 
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Unlocking a data record always clears down the active user connection. 

! Warning: All changes in the application since the last save are lost. 

 Confirm the message with Yes. 

 

Figure 119: Prompt to disconnect user from form 

When Alex Haselmere returns to his desk to work on the application in Form EP(1038E), he sees the following 
message: 

 Click OK. 

The form closes and can be reopened. 

 

Figure 120: Connection to server lost in Form EP(1038E) 
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15.3 Viewing the user sessions log (History) 

The History tab provides a chronological list of all user logon and logoff actions as well as the status of services 
in Online Filing. A separate log is available for each service. Older entries are automatically hidden. 

This enables the administrator to check user activities, perform troubleshooting and prevent any unauthorised 
activities. 

 Click the Refresh button to display the latest status. 

 
 Click a service (Plugin name) to display the associated log on the right. 

 

Figure 121: User activities log for File Manager 
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